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STM WiFi module 

We did this manual with maximum attention, but in any case:
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Introduction

WiFi module SPWF01S is available with antenna mounted and with connector to 
attach an external antenna.
The external antenna used for the certifications is: 
SAGRAD SG901-1066, more info are here and here.

Compliant: 
b/g/n, WEP, WPA, WPA2

WEB possibility of: 
Server/Client 

All the functionality of the module are accessed via AT commands.

The interface from STM WiFi module and MCU is via UART. 
The default parameters are: 

Baud 115200 
Data 8
Parity No
Stop 1
Flow Control No

JUMPERs on SILICA STM WiFi – Branca board
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JUMPERs on SAGRAD board

J1 is the optional External 5 to 15V Supply Input. Positive center pin. SANTEC TSW-106-
23-L-S 

J7 is used to monitor the external supply voltage. 

J8 is used as a jumper in case the resistor R10 is substituted to a 1 ohm resistor for module
power consumption only. J8 shorted will zero the 1 ohm R10 resistance in series with the 
module. 

J4 jumper is used for firmware loading control. Normally not used and pulled low internally. 

J9 and J10 jumpers select the mode of operation for USB serial or DB9 serial. USB serial is
jumpers J9 and J10 to pins 1 and 2.

SW1 is a manual switch to reset the module. 

D4, D5 and D6 LED’s are connected to the module GPIO’s 10, 13 and 14 respectively for 
software monitoring purposes.

The standard jumpers
configuration are: 
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Resource, available via STM WiFi pins are

16 GPIO 
OutPut (0/1)
InPut (Rising edge, Falling edge or Both rising and falling edges)

1 UART
For send and receive data
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Firmware update

It is possible via WiFi network (OTA) only with me module that mount the FLASH - 
SPWF01SA.11 or SPWF01SC.11 or via internal boot loader.
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HTML pages

Up to now, the max size of .html page in RAM is 2K (only text page, at the moment).
Is possible store the .html pages in Flash and in this case the limit of size is 64K.
Max Flash available for .html pages is 64K.

Up to now, inside the module there are this pages:

 I 461 /input_demo.shtml
 I 384 /output_demo.html
 I 614 /index.html
 I 157 /peers.shtml
 I 193 /config.shtml
 I 180 /message.shtml
 I 174 /status.shtml
 I 5496 /remote.html
 I 3447 /firstset.html
 I 212 /404.html

It is possible substitute the original .html page with our custom .html page.
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How to use the STM WiFi dongle

For send/receive commands to STM WiFi dongle on Windows7 we suggest to use Tera 
Term (http://en.wikipedia.org/wiki/Tera_Term - http://ttssh2.sourceforge.jp/index.html.en), 
on WindowsXP we suggest Hyper Terminal.
When you connect the STM WiFi dongle on your PC ( we suppose that you use 
Windows7) for see which COM port it is assigned, do this: 

Select: START  > Device and Printer
see below (1 and 2)
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The first time you connect the STM WiFi dongle to PC probably it request the driver 
(SILICON LABS CP2102 - VCP Driver Kit) that you get here.
http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx 
The USB/RS232 driver is available for:

Windows XP/Server 2003/Vista/7
WinCE
Macintosh OSX
Linux
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Commands

SetUp Commands for connect the STM WiFi module to a WiFi 
Router

at+s.ssidtxt=nome_router  
// Connect to WiFi router.
// Substitute nome_router with your WiFi-Router name
// see red box below

at+s.scfg=wifi_wpa_psk_text,network_password 
// SetUp the network password
// Substitute network_password with your WiFi-Router password

at+s.scfg=wifi_priv_mode,2 
// SetUp the protection mode used in your WiFi-router network
// 0 == OPEN
// 1 == WEP
// 2 == WPA

at+s.scfg=wifi_mode,1 
// Set radio mode to STA (client station)

at+s.scfg=ip_use_dhcp,1 
// Enable dhcp client. The WiFi-router give us the address. 

at&w 
// Save settings

at+cfun=1 
// Soft reset

At the end of the command show above the STM WiFi module is 
connect to WiFi network (see below).
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If WiFi network falls, the STM WiFi module highlight this (see the
orange box below) and start automatically a new scan for reconnect
the network.
See Below.
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SetUp Commands for Ad-Hoc network config 

No Privacy Mode
WEP Privacy Mode
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No privacy mode 

at+s.ssidtxt=xxxxxxxxx //Set Ad-Hoc network SSID
at+s.scfg=wifi_priv_mode,0 //Set Privacy open
at+s.scfg=wifi_mode,2 //Set Ad-Hoc mode
at+s.scfg=ip_use_dhcp,0 //Set DHCP off
at+s.scfg=ip_ipaddr,192.168.x.x //Set IP address for static usage
at+s.scfg=ip_gw,192.168.x.x //Set IP default gateway
at+s.scfg=ip_dns,192.168.x.x //Set IP DNS server
at+s.scfg=ip_netmask,255.255.255.0 //Set IP netmask
at&w
at+cfun=1

No privacy mode Example
at+s.ssidtxt=ADHOC //Set Ad-Hoc network SSID
at+s.scfg=wifi_priv_mode,0 //Set Privacy open
at+s.scfg=wifi_mode,2 //Set Ad-Hoc mode
at+s.scfg=ip_use_dhcp,0 //Set DHCP off
at+s.scfg=ip_ipaddr,192.168.1.3 //Set IP address for static usage
at+s.scfg=ip_gw,192.168.1.1  //Set IP default gateway
at+s.scfg=ip_dns,192.168.1.1  //Set IP DNS server
at+s.scfg=ip_netmask,255.255.255.0 //Set IP netmask
at&w
at+cfun=1

Click here to   go to Had-Hoc network config.
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WEP privacy mode 

Access point config
WEP Key length: 64 bit (10 hex digits)
WEP Key: xxxxxxxxxx

WEP privacy mode
at+s.ssidtxt=xxxxxxxxx //Set Ad-Hoc network SSID
at+s.scfg=wifi_priv_mode,2 //Set Privacy open
at+s.scfg=wifi_mode,2 //Set Ad-Hoc mode
at+S.SCFG=wifi_wep_keys[0],xxxxxxxxxx //Set WEP key (in hex)
at+S.SCFG=wifi_wep_key_lens,xx // Length of the actual key 

   data in each WEP key buffer.
at+s.scfg=ip_use_dhcp,0    //Set DHCP off
at+s.scfg=ip_ipaddr,192.168.x.x //Set IP address for static usage
at+s.scfg=ip_gw,192.168.x.x     //Set IP default gateway
at+s.scfg=ip_dns,192.168.x.x    //Set IP DNS server
at+s.scfg=ip_netmask,255.255.255.0 //Set IP netmask
at&w
at+cfun=1

Click here to   go to Had-Hoc network config.
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GPIO commands

ATTENTION: if you use STM WiFi Dongle remember that:
D4, D5 and D6 LED’s are connected to the module GPIO’s 10, 13 and 14 respectively for 
software monitoring purposes.

at+s.gpioc....
// Configure General Purpose Inputs/Outputs
// Arguments:
// <num> GPIO Number (0-15 on the SG901-1203)
// <direction> “in” or “out”
// <interrupt> Optional parameter:
// 0 Off
// R Rising edge
// F Falling edge
// B Both rising and falling edges
// Example:
AT+S.GPIOC=7,out // Set GPIO7 in OutPut
AT+S.GPIOW=7,0 // GPIO7 at 0
AT+S.GPIOW=7,1 // GPIO7 at 1
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General Commands

at+s.fsl 
// List the current files set in your STM WiFi module or dongle.
// See here.

at+s.fsp=/nomepagina.html 
// Print the contents of the file we created
// Example:
at+s.fsp=/index.html

at+s.ping=address 
// PING
// Example:
at+s.ping=192.168.0.1

at+s.scan 
// It does the wifi network scan

at+s.sts 
// Diplays the current values of all the status variables

at&v 
// Display the value of all config keys
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Create a filename.html

at+s.fsc=/FileName.html,Dimension
// Create a file (FileName.html) that dimension is Dimension in
// the STM WiFi RAM memory.
// Example:
at+s.fsc=/index.html,2038 // Create index.html that the size 

 //  is 2038 bit.
 //  Remember that the max size is 2Kbit  

at+s.fsa=/FileName.html,Dimension
// appends blocks of data to an existing file.
// Example:
at+s.fsa=/index.html,20
// after this command the STM WiFi module waiting to receive 
// 20 character.
// In the next page there is a complete example.
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Below there is a complete example

For use it copy and paste into Tera Term.

at+s.fsc=/index.html,2009
at+s.fsa=/index.html,2009
<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01//EN" 
"http://www.w3.org/TR/html4/strict.dtd">
<html><head><meta content="text/html; charset=ISO-8859-1" http-
equiv="content-type"><title>index.html</title></head><body><span 
style="font-family: sans-serif;">from: <a href="http://www.emcu.it" 
target="_blank"><big><big><span style="font-weight: 
bold;">www.emcu.it</span></big></big></a></span><br style="font-family: 
sans-serif;">
<br>
<span style="font-family: sans-serif; font-weight: bold; font-style: 
italic;">STM WiFi module</span><br style="font-family: sans-serif;">
<a href="../config.shtml"><span style="font-family: sans-serif;">SG901-
1203 configuration settings page</span></a><br style="font-family: sans-
serif;">
<a href="../status.shtml"><span style="font-family: sans-serif;">SG901-
1203 status page</span></a><br>
<br>
<span style="font-family: sans-serif; font-weight: bold;">Receive 
data</span><br>
<span style="font-family: sans-serif;">Click <a href="../cgi_demo.html" 
target="_blank">here</a>.</span><br style="font-family: sans-serif;">
<small><span style="font-family: sans-serif; font-style: italic;">The 
data are input in HTML page and are returned by STM-WiFi via 
RS232</span><span style="font-style: italic;">.</span></small><br>
<br>
<span style="font-family: sans-serif; font-weight: bold; font-style: 
italic;">EXTRA</span><br>
<span style="font-family: sans-serif;">For more info concerning: <br>
WireLess module see <a href="http://www.emcu.it/Wireless/Wireless.html" 
target="_blank">here</a><br>
STM8 (8bit MCU) see <a href="http://www.emcu.it/index.html#STM8" 
target="_blank">here</a><br>
STM32 (Cortex Mx) see <a href="http://www.emcu.it/index.html#STM32" 
target="_blank">here</a><br>
RFID see <a href="http://www.emcu.it/RFID/RFID.html" 
target="_blank">here</a><br>
MEMS see <a href="http://www.emcu.it/MEMS/MEMS.html" 
target="_blank">here</a><br>
PLM see <a href="http://www.emcu.it/PLM/PLM.html" 
target="_blank">here</a><br>
<br>
</span><br>
</body></html>
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How to use NotePad++

For count the bytes inside your html file I suggest to use NotePad++.
View → Summary
see below

Before download the html page configure the TeraTrerm as below.
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How to use Tera Term

At startup the Tera Term show the image below.
From this page you must select:
SERIAL
and the COM Port

When Tera Term  is open, select:
SETUP > TERMINAL
and the page below must appear. Please configure your TT exactly as show below.
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Now select:
SETUP > SERIAL PORT
Please configure your Tera Term  exactly as show below.

Now type:
at 
and press ENTER and you must see:

This means that your STM WiFi Dongle is connect to your PC.
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Copy and Past

To insert a long string in the Tera Term you simply copy the long string (form a file or from a
.pdf) and next, press the right mouse button inside the Tera Term windows.

To copy a text from Tera Term simply select the text; this is equivalent at copy command.

EXIT from Tera Term

For exit from Tera Term select:
File > Disconnect
next select:
File > Exit
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How to connect STM WiFi module to STM32F0-Discovery

My configuration is:
STM32F0-Discovery
KEIL C Compiler ver.4.60.0.0
STM WiFi module

Optionally: if you connect a led (see schematic below)

from PC6 and GND, you have the possibility to monitor the waiting from the 
answer from STM WiFi module.

Connections for: SILICA STM WiFi EvaBoard
Connections for: SAGRAD EvaBoard
How to do the connection
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Connections for: SILICA STM WiFi EvaBoard
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Connections for: SAGRAD EvaBoard

If you need monitor the strings that are sent from STM32F0-Discovery and 
from STM WiFi module do this:
Remove the jumper J9 and J4, next connect the STM WiFi module to the 
Tera Term.
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How to do the connection

• For do the connection (after loaded the SW on STM32F0-Discovery) 
just press and release the blue button on the STM32F0-Discovery.
At this point you see the Blue led that flashing and the Red led that 
changes from OFF to ON.

• After some seconds, Blue and Green leds are flashing and this means 
that the STM WiFi module is trying to connect to the WiFi Router.

• After 20/60 sec, Blue and Green leds go OFF and this means that the 
connection is done.

• If you use the SAGRAD WiFi module, the led D5 must be ON, this 
means that the WiFi connection is active.

• If you use the SILICA STM WiFi EvaBoard, the led LED2 (LINK) must 
be ON, this means that the WiFi connection is active.
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Now open the html page: cgi_demo.html
this page is used to send commands to STM WiFi Module.

• For do this you must know the IP address of the STM WiFi module.
• To find it I suggest to use the Angry IP Scanner.
• Suppose the the STM WiFI IP is: 168.169.0.5
• Open your browser and type: 

192.168.0.5/cgi_demo.html

The custom commands (implemented on STM32F0-Discovery) for control the
STM WiFi module are:

• lgon – TurnON the green LED
• lgoff – TurnOFF the green LED
• lbon – TurnON the blue LED
• lboff – TurnOFF the blue LED
• X – Clear RxBuffer
• reset – reset the STM WiFi module, it reload the WiFi configuration

 received from STM32F0-Discovery. 
 During the reset the Blue and Green Leds are flashing.

You have the possibility to see the LEDs status in the page:
192.168.0.5/led.html
Remember to reload the led.html page after every command send using the 
cgi demo.html page.
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ATTENTION

In the main.c there are the strings definitions used for connect the STM WiFi 
module to your WiFi Router.
Remember to configure the parameters in according to your WiFi 
network.
In particular, be sure to specify:

• Router Name (see the orange line below) 
• Router Password (see the yellow line below – password)

For example:
uint8_t TxBuffer_RouterName[] = "at+s.ssidtxt=NETGEAR-3G\n\r";
uint8_t TxBuffer_RouterPW[] = "at+s.scfg=wifi_wpa_psk_text,free\n\r";

Below there are the lines of code involved in creation of appropriate led.haml
page.

uint8_t TxBuffer_Delete_led_page[] = "at+s.fsd=/led.html\n\r"; // Delete led.html page
uint8_t TxBuffer_Prepare_led_page[] = "at+s.fsc=/led.html,192\n\r";
uint8_t TxBuffer_Prepare_led_page_upload[] = "at+s.fsa=/led.html,192\n\r";
uint8_t TxBuffer_led_page[] = "<html><head><meta content='\22'text/html; charset=ISO-8859-1\0x22 http-
equiv=\0x22content-type\0x22><title>Leds.html</title></head><body> <br>Green_Led is OFF <br>Blue_Led
is OFF<br></body></html>\r\n";
uint8_t TxBuffer_led_pageLVonLBoff[] = "<html><head><meta content='\22'text/html; charset=ISO-8859-
1\0x22 http-equiv=\0x22content-type\0x22><title>Leds.html</title></head><body> <br>Green_Led is ON  
<br>Blue_Led is OFF<br></body></html>\r\n";
uint8_t TxBuffer_led_pageLVonLBon[] = "<html><head><meta content='\22'text/html; charset=ISO-8859-
1\0x22 http-equiv=\0x22content-type\0x22><title>Leds.html</title></head><body> <br>Green_Led is ON  
<br>Blue_Led is ON <br></body></html>\r\n";
uint8_t TxBuffer_led_pageLVoffLBon[] = "<html><head><meta content='\22'text/html; charset=ISO-8859-
1\0x22 http-equiv=\0x22content-type\0x22><title>Leds.html</title></head><body> <br>Green_Led is OFF 
<br>Blue_Led is ON <br></body></html>\r\n";
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If you need the software, please request it to me by email:
• em.mcu@libero.it 
• enrico.marinoni@silica.com

ATTENTION: this SW is available only for:
• SILICA Customers
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How to scan your local network

For scan your local network I suggest to use:
Angry IP Scanner 
that is here:
http://sourceforge.net/projects/ipscan/?source=dlp 

Below there are two scans.
In the left windows, the STM WiFi module is not connected to the WiFi 
network.
In the right windows, the STM WiFi module is connected  to the WiFi network.
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How to use PYTHON on LINUX to drive STM WiFi module

My configuration is:
XUBUNTU
SPE (PYTHON IDE)
For developing the example below I used the pySERIAL package that 
you find here:
http://pyserial.sourceforge.net/index.html

Connect STM WiFi module to your PC.
Open a Linux Terminal and use the commands below to see the USB 
assigned to STM WiFi module.

lsusb
and you must see something like this:
Bus 001 Device 001: ID 1d6b:0002 Linux Foundation 2.0 root hub  
Bus 003 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub 
Bus 004 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub 
Bus 005 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub 
Bus 005 Device 015: ID 1267:0210 Logic3 / SpectraVideo plc LG Optical Mouse 3D-310 
Bus 003 Device 005: ID 10c4:ea60 Cygnal Integrated Products, Inc. CP210x Composite Device

The last line is the STM WiFi module

dmesg
and you must see something like this:

[107414.672148] usb 3-1: USB disconnect, device number 4 
[107414.672536] cp210x ttyUSB0: cp210x converter now disconnected from ttyUSB0
[107414.672580] cp210x 3-1:1.0: device disconnected 
[109328.688115] usb 3-1: new full-speed USB device number 5 using uhci_hcd 
[109328.914272] cp210x 3-1:1.0: cp210x converter detected 
[109329.028116] usb 3-1: reset full-speed USB device number 5 using uhci_hcd 
[109329.176428] usb 3-1: cp210x converter now attached to ttyUSB0 

The last line is the USB name (ttyUSB0) assigned to STM WiFi module.

Remember that before use your serial port you must change the permission 
on it.
To do this use the commands below.
cd /dev
if your serial port is ttyUSB0 use this command:
chmod 777 ttyUSB0
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The PYTHON examples are very easy and they are below.

EXAMPLE n.1
# by www.emcu.it - LINUX and STM WiFi module 
# Remember that before use your serial port you must change the permission on it.
# To do this use the commands below.
# cd /dev
# if your serial port is ttyUSB0 use this command:
# chmod 777 ttyUSB0

import serial # Inport serial package
ser = serial.Serial('/dev/ttyUSB0', 115200, timeout=1) # Open the serial: /dev/ttyUSB0
print "We have opened the serial port: ", ser.portstr # Visualize the name of the serial com
ser.write("AT\r\n") # Send AT + cr +lf
s = ser.read(10) # Read from ttyUSB0
print "We have received: \n", s   # Visualize the return from ttyUSB0
ser.close() # close port

EXAMPLE n.2
#!/usr/bin/env python
#
# On Unix BSD and Linux, Python scripts can be made directly executable, like shell scripts, 
# by putting the script the above line. -> #!/usr/bin/env python
#
#
# by www.emcu.it - LINUX and STM WiFi module
#
# Remember that before use your serial port you must change the permission on it.
# To do this use the commands below.
# cd /dev
# if your serial port is ttyUSB0 use this command:
# chmod 777 ttyUSB0

import serial # Inport serial package

SWver = "The SW Version is 1.1 - by www.emcu.it"

def help():
    print " "
    print "+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
+"
    print " The commands that you have are:"
    print " -ls   -> for list the HTML pages that are on STM_WiFi_Module"
    print " -ver  -> for know the version of this SW"
    print " -scan -> for Scan the WiFi network"
    print " -stat -> for know the status of the STM WiFi module"
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    print " -var  -> for see the list of all variables of the STM WiFi module"
    print " -help -> for show the commands available"
    print " -exit -> for exit from this program"
    print " ATTENTION: the commands must send via Web Browser; "
    print " not typed directly into this command windows."
    print "+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++"
    print " "

def start():
    print " "

    print "+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++"
    print " This PYTHON SOFTWARE was tested on LINUX"
    print " "
    print " Remember that before use your serial port you must change the permission on it."
    print " To do this use the commands below."
    print " cd /dev"
    print " if your serial port is ttyUSB0 use this command:"
    print " chmod 777 ttyUSB0"
    print "+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++"
    print " "

# Input ComPort name
start()
ComPort = raw_input("Input the name of ComPort where is connected the STM_WiFi module: ")
# Configure the ComPort with timeout of 1s
# Open Serial-COM at 115200,8,N,1, 1s timeout
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=1)
print "We have opened the serial port:", ser.portstr  # Visualize the name of the serial com

ser.write("AT\r")    # Send AT + cr
ser.flush()             # it is buffering. required to get the data out *now*
s = ser.read(150)  # Read from serial port

# Test the answer from STM_WiFi
ATok="AT\r\n\r\nOK\r\n"
if s == ATok:
    print " ***** OK: STM_WiFi is connected to PC"
if s <> ATok:
    print " ***** ERROR: No answers from STM_WiFi"
 
# Input WiFi Network Name
WiFiNetName = raw_input("Input the name of WiFi Network: ")
atNetName = "at+s.ssidtxt=" + WiFiNetName + "\r\n"
ser.write(atNetName)
ser.flush()               # it is buffering. required to get the data out *now*
s = ser.read(150)    # Read from serial port
print s

# Input WiFi Network Password
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WiFiPW = raw_input("Input the WiFi Password: ")
atPW = "at+s.scfg=wifi_wpa_psk_text," + WiFiPW + "\r\n"
ser.write(atPW)
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(150)   # Read from serial port
print s

# Set WPA-PSK
ser.write("at+s.scfg=wifi_priv_mode,2\r\n")
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(150)   # Read from serial port
print s

# Set Radio mode Standard
ser.write("at+s.scfg=wifi_mode,1\r\n")
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(150)   # Read from serial port
print s

# Set DHCP ON 
ser.write("at+s.scfg=ip_use_dhcp,1\r\n")
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(150)   # Read from serial port
print s

# Set Save Setting 
ser.write("at&w\r\n")
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(150)   # Read from serial port
print s

# Set Soft Reset 
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=15)
print "Now STM_WiFi is under reset... have patience for 15...30 second."
ser.write("at+cfun=1\r\n")
ser.flush()              # it is buffering. required to get the data out *now*
s = ser.read(700)      # Read from serial port
print s
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=1)

print " "
print "++++++++++++++++++++++++++++++++++++++++++++++"
print " If you see something like this:"
print " .....WiFi Up: 192.168.0.14" 
print " means that you are connected to WiFi network."
print "++++++++++++++++++++++++++++++++++++++++++++++"
print " "

print " The HTML pages that are on STM_WiFi_Module are listed below"
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ser.write("at+s.fsl\r\n") # List the HTML pages that are on STM_WiFi_Module
ser.flush()               # it is buffering. required to get the data out *now*
s = ser.read(700)   # Read from serial port
print s

# Infinite loop, for exit CTRL C
print " Now you are in infinite RX loop. "
help()
while 1:
    s = ser.read(700)   # Read from serial port
    if s !="":  
        print s
        if s == "-help\r\n":
            help()
        if s == "-var\r\n":
            ser.write("at&v\r\n")
            ser.flush()              # it is buffering. required to get the data out *now*
            s = ser.read(5000) # Read from serial port
            print s
        if s == "-scan\r\n":
            ser.write("at+s.scan\r\n")
            ser.flush()              # it is buffering. required to get the data out *now*
            s = ser.read(5000) # Read from serial port
            print s
        if s == "-stat\r\n":
            ser.write("at+s.sts\r\n")
            ser.flush()              # it is buffering. required to get the data out *now*
            s = ser.read(5000) # Read from serial port
            print s
        if s == "-exit\r\n":
            print "++++++++++++++++++++++++++++++"
            print " Thank you for using this SW." 
            print " Come find me at: www.emcu.it"
            print "++++++++++++++++++++++++++++++"
            print " "
            break
        if s == "-ver\r\n":
            print SWver
            print " "
        if s == "-ls\r\n":
            ser.write("at+s.fsl\r\n")
            ser.flush()                # it is buffering. required to get the data out *now*
            s = ser.read(5000)   # Read from serial port
            print s

ser.close()   # close port 
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How to use PYTHON on Windows 7 to drive STM WiFi module

Python 

Download and install the Python ver.2.7.3 from this link:
http://www.python.it/download/
I suggest the release 2.7.3 because the Spyder support this release (see 
below).

Python IDE 

A complete list of Python IDE are here:
http://wiki.python.org/moin/IntegratedDevelopmentEnvironments 

I suggest to use Spyder because is multi platform IDE.
http://code.google.com/p/spyderlib/downloads/list 
download and install this release:  spyder-2.1.11_py27.exe

Now is necessary install the PyQt4 that is here:
http://www.riverbankcomputing.co.uk/software/pyqt/download 
download and install this release: PyQt-Py2.7-x86-gpl-4.9.6-1.exe 

pySERIAL 
For developing the example below I used the pySERIAL package that you 
find here:
http://sourceforge.net/projects/pyserial/ 
The documentation is here:
http://pyserial.sourceforge.net/index.html 

The list of files that you must install are below.
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Now is necessary configure the environment variables. For do this 
follow the steps below.

Now restart your PC.
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For check if all is ok open a terminal:
Start → All Programs → Accessories → Command Prompt
and type: python
you must see something like below.

Now you are ready to develop in PYTHON.
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EXAMPLE n.1
# by www.emcu.it – Windows 7 and STM WiFi module 
# I suppose that the serial-com is: COM26

import serial # Inport serial package
# Open the serial-com
ser = serial.Serial('COM26', 115200, timeout=1) 
# Visualize the name of the serial-com
print "We have opened the serial port: ", ser.portstr 
ser.write("AT\r\n") # Send AT + cr +lf
s = ser.read(10) # Read from serial-com
# Visualize the return from serial-com
print "We have received: \n", s 
ser.close() # close port

Open SPYDER and copy, in a new project, the code shown above.
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EXAMPLE n.2
# -*- coding: utf-8 -*-

"""
Created on Sat Dec 15 21:00:20 2012

@author: marinonie
"""

#!/usr/bin/env python
#
#
# by www.emcu.it
#

import serial # Inport serial package

SWver = "The SW Version is 1.1 - by www.emcu.it"

def help():
print " "
print "++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++"
print " The commands that you have are:"
print " -ls -> for list the HTML pages that are on STM_WiFi_Module"
print " -ver -> for know the version of this SW"
print " -scan -> for Scan the WiFi network"
print " -stat -> for know the status of the STM WiFi module"
print " -var -> for see the list of all variables of the STM WiFi module"
print " -help -> for show the commands available"
print " -exit -> for exit from this program"
print " ATTENTION: the commands must send via Web Browser; "
print " not typed directly into this command windows."
print "++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++"
print " "

def start():
print " "
print "++++++++++++++++++++++++++++++++++++++++++++"
print "  This PYTHON SOFTWARE was tested on Windows 7"
print "++++++++++++++++++++++++++++++++++++++++++++"
print " "

# Input ComPort name
start()
ComPort = raw_input("Input the name of ComPort where is connected the STM_WiFi module: ")
# Configure the ComPort with timeout of 1s
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# Open Serial-COM at 115200,8,N,1, 1s timeout
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=1)
print "We have opened the serial port:", ser.portstr # Visualize the name of the serial com

ser.write("AT\r") # Send AT + cr
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port

# Test the answer from STM_WiFi
ATok="AT\r\n\r\nOK\r\n"
if s == ATok:
print " ***** OK: STM_WiFi is connected to PC"
if s <> ATok:
print " ***** ERROR: No answers from STM_WiFi"
# Input WiFi Network Name
WiFiNetName = raw_input("Input the name of WiFi Network: ")
atNetName = "at+s.ssidtxt=" + WiFiNetName + "\r\n"
ser.write(atNetName)
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s

# Input WiFi Network Password
WiFiPW = raw_input("Input the WiFi Password: ")
atPW = "at+s.scfg=wifi_wpa_psk_text," + WiFiPW + "\r\n"
ser.write(atPW)
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s

# Set WPA-PSK
ser.write("at+s.scfg=wifi_priv_mode,2\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s

# Set Radio mode Standard
ser.write("at+s.scfg=wifi_mode,1\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s

# Set DHCP ON 
ser.write("at+s.scfg=ip_use_dhcp,1\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s
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# Set Save Setting 
ser.write("at&w\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(150) # Read from serial port
print s

ser.close() # close port
# Oper port 
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=15)
# Set Soft Reset
print "Now STM_WiFi is under reset... have patience for 15...30 second."
ser.write("at+cfun=1\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(700) # Read from serial port
print s

print " "
print "++++++++++++++++++++++++++++++++++++++++++++++"
print " If you see something like this:"
print " .....WiFi Up: 192.168.0.14" 
print " means that you are connected to WiFi network."
print "++++++++++++++++++++++++++++++++++++++++++++++"
print " "

ser.close() # close port
# Oper port
ser = serial.Serial(ComPort, 115200, bytesize=8, parity='N', stopbits=1, xonxoff=0, rtscts=0, 
timeout=1)

print " The HTML pages that are on STM_WiFi_Module are listed below"
ser.write("at+s.fsl\r\n") # List the HTML pages that are on STM_WiFi_Module
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(700) # Read from serial port
print s
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# Infinite loop, for exit CTRL C
print " Now you are in infinite RX loop. "
help()
while 1:

s = ser.read(700) # Read from serial port
if s !="": 

print s
if s == "-help\r\n":

help()
if s == "-var\r\n":

ser.write("at&v\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(5000) # Read from serial port
print s

if s == "-scan\r\n":
ser.write("at+s.scan\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(5000) # Read from serial port
print s

if s == "-stat\r\n":
ser.write("at+s.sts\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(5000) # Read from serial port
print s

if s == "-exit\r\n":
print "++++++++++++++++++++++++++++++"
print " Thank you for using this SW." 
print " Come find me at: www.emcu.it"
print "++++++++++++++++++++++++++++++"
print " "
break

if s == "-ver\r\n":
print SWver
print " "

if s == "-ls\r\n":
ser.write("at+s.fsl\r\n")
ser.flush() # it is buffering. required to get the data out *now*
s = ser.read(5000) # Read from serial port
print s

ser.close() # close port 
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